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Software Introduction 

 

Cube-link is a free version of the software Cube-manager. It offers tools for the transferring 

and processing of data from GNSS receivers and total stations.  

 

The application has a modern Microsoft interface and implements a CAD, easy to use and 

flexible, which allows you to view data in both 2D and 3D. It offers functions for graphical 

and tabular displaying of raw data and results; some COGO commands; functions for 

importing and exporting data, using standard file formats such as DXF or CSV and manages 

the most common vector entities (lines, polylines, circles, arcs, texts, etc). 

 

The Cube-link also supports a special point entity called the Topographic Point. 

Topographic points are the fundamental parts of each survey and are generated by 

importing data or using specific tools. These must be considered as a data structure that 

contains all the information acquired during the topographic survey, even if obtained from 

multiple surveys of the GNSS or TPS type. For example: importing a GNSS survey generates 

topographic points that will be represented by symbols and with different graphic 

properties. These must be considered as a data structure that contains all the information 

acquired during the topographic survey, both relative to the position, such as coordinates 

(east, north, height, latitude, longitude, elevation) but also related to accuracy and control 

(e.g. Residuals), and information on working methods (e.g. RTK differential correction). 
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1 Installing and uninstalling Cube-link 
 

1.1 Cube-link installation 

 

To install Cube-link just start the installer, select the language (which can be changed at any 

time even with the installed program), read and accept the user license agreement, select 

the folder for the location of the shortcuts and choose whether to create a shortcut to the 

program from the desktop. Before clicking the Install button, you can check and possibly 

change the location of the program folder, the start menu folder and any additional tasks, 

such as the creation of a desktop shortcut. 

 

The setup is available for 32-bit and 64-bit platforms. 

 

1.2 Cube-link uninstallation 

 

To uninstall, go to the folder where the program is located and press the uninstall button 

that will execute the operation. 
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2 General functions 
 

2.1 File (tab) 

 

File is the first tab and is located at the top left of the main screen. This section contains 

many utility commands, including one for settings, and for import and export operations 

(Figure 2.1). The commands at the bottom provide general information: by clicking the 

Release notes command, you can access the file with a summary of all the information 

concerning the new versions and the updates of the program; Online Manual is the 

command that opens the PDF of the User Manual; Information opens the general 

presentation window of the software, where you can see the installed version number and 

the active module or modules. 
 

 
Figure 2.1 
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2.1.1 Create, open and save jobs 

 

Cube-link files have .cubelnk extension and contain all the CAD and topographic entities 

used during processing. When you want to create a new job, the application asks if you want 

to create a new blank job with default variables or if you want to proceed with a new job 

with variables from template files, it is in fact possible to save template files ( with extension 

.cubetpl) that contain all the settings used for a project (variable dimensions, parameter 

settings, levels, etc.). 

 

Saving jobs will include the possibility to save a project file or a template file. 

 

Recent projects are saved in a list in the File menu (Recent projects command). Selecting a 

project from this list and hovering the mouse over will display a preview of the job graphics. 
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2.1.2 Imports 

 

Cube-link allows you to import files in different formats, including the Cube-a format. To 

import, just select a format from the list shown in the Import menu (Figure 2.2), each choice 

will open a new window (for details refer to the paragraphs related to the different imports). 

 

 

 
Figure 2.2 

 

 

 

Figure 2.3 

  



 

 

 

 

 

 

Stonex Cube-link v4.3 – User manual     10 

 

2.1.2.1 Import Cube-a 

 

To import a Cube-a file you can select the relevant command in the File tab or you can click 

on the Cube-a import icon in the Home tab (Figure 2.3). In case of importing Cube-a files, 

the system can operate on single files or on files that are in specific folders. The second case 

occurs when the user has access to the entire Cube-a project folder and selects the file with 

the extension .pd contained in it. 

In Cube-a, a job is stored in a folder that has the same name of the project and has subfolders 

containing all the data; the file to be imported is in the subfolder called "Data". 

Copying the entire project folder allows the program to access data files such as photos and 

reference system information. Within Android devices, projects are always stored as 

subfolders of the "StonexCube/Projects" folder. 

Figure 2.4 shows the main screen for exporting a Cube-a file. After selecting the file, a 

reference system must be set up before proceeding. You can use the reference system 

previously defined in the Cube-link (at start-up the program will automatically always check 

if a default reference system has been set) or you can use coordinates defined in the field. 

In addition, you can set up a local system or a default reference system, in which case the 

program will allow you to access the relevant windows for the settings. 

 

If there are photos in the file, you can transform them into GeoTIFF. 

 

For leap seconds a default value is proposed which can be changed during the import phase. 

 

 
Figure 2.4 
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2.1.2.2 Import RW5 

 

To import an RW5 file you can select the relevant command in the File tab or you can click 

on the Import RW5 icon in the Home tab (Figure 2.3). You will see a window as in Figure 2.5, 

where you can specify the name and path of the file you want to import. A useful feature is 

the ability to select the CRD file and then import only the updated data found in the field (if 

you import raw files, the option on CRD files will not be visible). 

Also, for this type of import the coordinates can be changed by selecting a local system or 

a predefined system, or leave the coordinates defined in the field or use the default reference 

system (set by the user when the program starts). 

If you want to use the USB connection to import, click on Connect USB (the connection is 

possible using the Windows Mobile Device Center program). The device used in the field 

can be connected directly to the PC and through the window in Figure 2.6, it is possible to 

directly download the files from the portable device to the PC or vice versa. By default, the 

program always shows the folder with the recorded data, but this position can be modified 

at will, clicking on the search button, you can then view the internal structure of the device 

and select the desired folder. 

 

 
Figure 2.5 
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Figure 2.6 
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2.1.2.3 Import Geogis 

 

To import a Geogis file, you can select the relevant command in the File tab or you can click 

on the Import Geogis icon in the Home tab (Figure 2.3). 

If there are photos in the project, they can be transformed into GeoTIFF files. Furthermore, 

even for GeoGis files it is possible to connect a device to the PC via the USB connection (with 

the same logic and functionality illustrated in the paragraph concerning the importation of 

RW5 files). 

 

With the USB connection even Raster, DXF and ESRI Shapefiles can be copied to the PC. To 

do this, simply select the format chosen with the drop-down menu command at the top of 

the screen. 

For this format as well, it is possible to import the coordinates surveyed in the field or use 

the default reference system, a local system or select a Datum. In the last two cases you will 

have the possibility to access windows where to set the characteristics of these systems. 

 

2.1.2.4 Import ASCII 

 

To import a text file, you can select the relevant command in the File tab or you can click on 

the Import ASCII icon in the Home tab (Figure 2.3). This function consists of 3 steps. 

In the first (Figure 2.7), you will have to select the file to be imported indicating name and 

path, in this step you can also edit the file by clicking on the Edit file button (this choice will 

open a simple text editor where you can edit the files and the number of lines can be 

displayed or hidden). Before proceeding you can select the encoding and whether to create 

topographic points or CAD points from the imported file. 

 

In step n. 2 (Figure 2.8), you must choose the file format, either standard formats or a custom 

one (Figure 2.9). Choosing the Custom format, you will have to enter a name for the format 

and the separator character in the section below. The inserted custom formats can also be 

deleted using the Delete selected command, located on the right, next to the drop-down 

menu for selection. 

Before proceeding to the next step, you must select the angular unit of measurement for 

reading latitude and longitude and the row number from where to start reading the data (to 

exclude a possible header, for example). 

 

In step n. 3 (Figure 2.10), it is possible to assign the type of content (Point name, Coordinate 

X, Y, Z; Description; Code; etc) to each column (click on the heading to display the list). This 

will save the new layout with the fields selected, the layouts cannot be overwritten. 
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Figure 2.7 

 
Figure 2.8 
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Figure 2.9 

 

 
Figure 2.10 
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2.1.2.5 Create map 

 

To create a map, you can click the Map from web button on the File tab or you can click on 

the Create Map icon in the Home tab (Figure 2 3). 

This function imports a map into the project, it will require the East and North that you want 

to set as the center of the map. You will then see a window powered by Google Maps as in 

Figure 2.11. To import the map into the CAD you will need to save the image as jpeg. The 

services for creating maps are two: Google and Bing. The window and the creation occur, in 

both cases, in the same way. If the created images do not cover the area in which you want 

to create the map, you can increase the horizontal and vertical images, or you can proceed 

to create a new map in addition to the one created. The program will overlay the geo-

referenced images. 

The images downloaded using these services are subject to copyright and in the case of 

Google maps it is possible that after a quantity of free downloads the service requires a 

payment. 

 

 
Figure 2.11 
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2.1.2.6 Send to AutoCAD 

 

Availability Module 

Cube-manager P-T-M 

 

2.1.2.7 Print 

 

The Print command generates a window that includes three tabs: Print settings; Printing 

styles; Printing tables. Print Settings (Figure 2.12) is the tab where you can set the printer 

you want to use and the page you want to print. Even the scale, origins, print area and print 

size can be set in this section. 

 

In the Printing Styles tab, you can set the thickness, terminations and joints, using the layer 

settings or creating new styles. You can also import previously saved styles or save new ones 

(Figure 2.13). 

 

The last tab Printing tables is dedicated to saving, deleting or loading print tables. In each 

of the tabs just described, you can click on the print preview button (Preview and print) to 

see a layout of how the file will be printed.  
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Figure 2.12 
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Figure 2.13 

 

2.1.2.8 DXF/DWG 

 

This function allows the system to import the graphic elements as they are and since there 

are no topographic points in this type of file it is possible to force this choice, so that the 

entities with attributes become topographic points (Figure 2.14). 

If you decide to import by transforming the points into topographic points, you will have 

the possibility to establish the name (sequential) of the points and the properties of the 

imported block. You can also select the option to import points on a single layer, in this case 

the current project layer will be selected. 
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Figure 2.14 

 

2.1.2.9 Pregeo 

 

The program supports the processing of Pregeo files, but this function is only visible in the 

Italian version. To access it, just set the Italian language from the change languages button. 
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2.1.2.10 Digital map extract EMP 

 

 

Availability Module 

Cube-manager P-T-M 

 

It is possible to import a file with the .EMP extension simply by indicating the name and path 

of the file from the screen that will be generated by clicking on the EMP Digital Extract 

command from the File tab (example of a project with imported EMP extract Figure 2.15). 

This is a Pregeo function (italian). 

 

 
Figure 2.15 
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2.1.2.11 ESRI Shapefile 

 

The import of a shapefile generates a screen like the one in Figure 2.16. Clicking Open at the 

top right you will see a preview of the work you are importing, on the left you will see the 

layers that make up the file. By clicking Import you can finish the preview and re-enter the 

graphic view in the main window. 

 

 

 
 

Figure 2.16 

 

 

2.1.2.12 Features of GPS points 

 

Whenever you decide to import GPS points into the program, Cube-manager will 

automatically display a screen, as shown in Figure 2.17. 

From this window it is possible to set the graphic appearance of the points, subdividing them 

according to the type of solution that characterizes them. It will then be possible to set the 

layer, the color and the icon of the symbol, divided by type of points. The size of the symbol, 

the font and its color can be set for the total number of points that are being imported. 

Note: GPS stations are by default positioned on a non-visible layer, however it is always 

possible to reactivate the layer, and set the color and icon of the symbol. 
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Figure 2.17 

 

2.1.3 Export  

 

Cube-link supports various export formats, in Figure 2.18 all possible exports are 

summarized. To access the exporting in various formats, click on the Export command in the 

File tab (Figure 2.1). 

 

 
Figure 2.18 
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2.1.3.1 Export Cube-a 

 

To export in Cube-a format, simply select the name and path of the file to be created, by 

default the program exports both graphical entities and topographic points. However, it is 

also possible to exclude graphical entities and to export only topographic points (Figure 

2.19). 

 

 
Figure 2.19 
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2.1.3.2 Export RW5 

 

To export in this format, you must select a file name and path, optionally you can also create 

an EzSurv file, you will always need to select a file name and path. You can also create a CRD 

file associated with the created RW5 file (Figure 2.20). 

 

 
Figure 2.20 

 

2.1.3.3 Export GeoGIS 

 

The export of a GeoGIS file is like the export of a Cube-a, it will be necessary to set a file 

name and a path. By default, both points and graphic entities are exported, but it is always 

possible to exclude the graphic entities from the export. 
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2.1.3.4  DXF/DWG file 

 

This export is the only one that can be recalled from two different commands within the 

program. First command is into the menu in Figure 2.18, like all other exports, the second is 

the Dxf/Dwg Out command in the Home tab (Figure 2.3). 

For a correct exporting, the first choice to make is the version of AutoCAD® that you want 

to use to create the file. Then you can select the options on the entities, especially if you 

want to include Raster images, backgrounds and topographic points. 

In case of simple topographic points, not as INSERT, the window on the right called Options 

for displaying points will be enabled. In this section you can set the size (as an absolute 

value, as %5 of the drawing area or as a percentage of the viewport) and the symbol for 

viewing the points in AutoCAD®. In the general options section, you can enter the text size 

and choose to create a 2D DXF file (Figure 2.21). 

 

 
Figure 2.21 
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2.1.3.5 Export on text file 

 

To create a text file just click on the Export points to text file button (Figure 2.18). The creation 

of the file is customizable, and it is possible to define the characteristics that you want to 

give to it: you can choose whether to include a header, the data to be inserted, the separator 

character, the format of the geographical coordinates etc. (Figure 2.22) 

 

 
Figure 2.22 

 

2.1.3.6 Export an image file (bmp, jpg, etc.) 

 

Availability Module 

Cube-manager P-T-M 
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2.1.3.7 Export in Google (KMZ) 

 

By accessing the Export to Google (KMZ file) function, you can generate a KMZ file that can 

be viewed in Google Earth, this export is possible only if there is a fieldbook in the current 

job. The procedure is like the other exports of this application; first specify a name and a 

path for the file, then proceed with selecting the features you want to add. The structure of 

this window is very flexible because you can indicate which data to export; including CAD 

elements, GPS data, photos, database attributes. As soon as the file is created, the program 

will ask if you want to load it directly in Google Earth (Google Earth must have been 

previously installed in the PC). 

 

 

2.1.3.8 ESRI Shapefile (shp) 

 

The steps for creating an ESRI shapefile file (Figure 2.23) are like those applied to the export 

of other formats, once selected the name and location of the file to be exported, you can 

select a series of information and contents that you want attribute to the file. 

 

 
Figure 2.23 
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2.1.4 Settings 

 

In Settings (command in the File tab), you can set the general program functions, such as 

checking for updates at startup or the version of AutoCAD® to be used (Figure 2.24). This 

function consists of 4 tabs that will be discussed below. It will allow you to completely 

customize the aesthetic, functional and practical aspects of the program. Note: to make sure 

that the changes are effective, after changing the settings, it is advisable to restart the 

program. 

 
Figure 2.24 

 

In the Appearance tab (Figure 2.25) you can determine, for example, the background color 

of the work area or enable dynamic information on the cursor. 

Among the other functions available there is the possibility to enable/disable the dynamic 

list of features, the display of the thicknesses on the screen, the size of the Cartesian axes’ 

icon. 
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By enabling the dynamic list of features, you can read the characteristics of the elements in 

the project. If you hover the mouse over the elements, the application will display a popup 

window, like the ones below (Figure 2.26), which will describe the type element and its 

characteristics. 

 

 
Figure 2.25 

 

  
 

Figure 2.26 
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The Help tab (Figure 2.27) is useful for setting the use of the Object Snap and in which mode 

and whether to enable or disable polar pointing and Ortho mode. Furthermore, in this 

section it is possible to customize the size of the Osnap symbol and the size of the selection 

area when this mode is active. 

 

 
Figure 2.27 

 

In the System tab it is possible to set the topographic unit of measure and the decimal 

figures for the display of parameters such as heights, coordinates, distances, etc. 

Regarding the representation of the angles, which is a setting in this section, there are two 

possibilities: the representation of the topographic angle and GPS and the representation of 

the general angle, which concerns the graphics. The representation of the angle relative to 

the topography is set by default in Grads but when a fielbook is imported, the application 

will read the configurations of the job and set the representation accordingly. 
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From the File tab, the Set Graphic Styles command (Figure 2.28, Figure 2.29) is available in 

the program Cube-manager. 

 

 
Figure 2.28 

 

 

 
Figure 2.29 
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From the File Tab it is also possible to access the Upload utility files function which has the 

purpose of uploading files of three categories (Figure 2.30): image files, database files (only 

available in the program Cube-manager), geoids.  

 

 
Figure 2.30 

 
Figure 2.31 

 

You can check how many and which fieldbooks are present in a job by accessing the 

Fieldbook List function. In Figure 2.31, the information displayed is: the name of the 

fieldbook, the type, the number of stations and the number of points. The operations that 

can be performed are: change the visibility of the fielbook (by clicking on the light bulb icon 

on the left) and delete the fielbook. By deleting a fieldbook it is also possible to delete the 

topographic points contained in it. 

 

The last two commands in the File tab are: Check for updates and Activate Cube-manager. 

The first command is for manually check if program’s updates are available. Every time the 

application is started, an automatic check will be carried out to check the availability of new 

updates (default choice, it can be changed from the Settings section). However, you can also 

manually check for updates by clicking the button described above. If an update is available 



 

 

 

 

 

 

Stonex Cube-link v4.3 – User manual     34 

and you decide to download it, the program will ask you to select in which folder you want 

to save the executable file, after which the download will start automatically. 

The Activation Cube-manager button is available only in the program Cube-manager. 

 

2.2 Home (tab) 

 

The Home tab is located at the top of the main screen and contains several sections (Figure 

2.32), including the In/Out section (Figure 2.3) described in paragraph 2.1.2, which contains 

all the formats available for import into the program. 

 

 
Figure 2.32 

2.2.1 Zoom, Clipboard 

 

The Zoom section contains numerous commands for zooming and selecting items in 

graphics. The commands are: Limits, Window, On point, Magnifier and Zoom that allows you 

to access a submenu to select the zoom in, zoom out or dynamic pan of the graphic (Figure 

2.33). In the Clipboard section you can find the classic copy-paste function. 

 

 

 
Figure 2.33 
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2.2.2 Layer 

 

The Layer section is used to manage the various layers in the project. By clicking on the 

Modify button (Figure 2.34, red circle), you can access the window in Figure 2.35, where you 

can operate on layers with visibility, selection or block functions. 

Layers can also be managed via the Layer Properties Management window, which can be 

accessed by clicking on the related icon on the main screen (Figure 2.36). In the layer 

properties window (Figure 2.37), you can create new layers and delete others (in order to 

delete a layer this must not be used and deselected, a layer is not used when it does not 

contain graphic elements or topographic points). 

This window displays all the available layers and their classic characteristics, such as color 

and type of line, from here you can print the contents of a layer and decide whether to show 

the names and symbols present (by clicking on the eye icon). You can also operate on 

visibility (light bulb icon). 

 

 
Figure 2.34 

 
Figure 2.35 

 

 
Figure 2.36 
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Figure 2.37 
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2.2.3 DB 

 

Availability Module 

Cube-manager (Figure 2.38) P-T-M 

 

 

 

 
Figure 2.38 

 

2.2.4 Language 

 

By pressing the language button, you can select the language of the program. We 

recommend restarting the program after changing the language. 
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2.3 CAD (tab) 

 

By clicking on the CAD tab (Figure 2.39), it is possible to access the area dedicated to design 

and CAD processing, which aims to support and integrate the topographic elements. 

These functions are like AutoCAD® ones and its many clones. This section is divided into 

two parts: draw and modify. In the Draw section (Figure 2.40) you can find commands to 

draw CAD entities such as lines, polylines, polygons and so on. Once you have selected the 

element you want to draw, just follow the instructions (represented by the suggestions that 

will appear on the screen and/or before the command line) to complete the command 

(Figure 2.41, example of a suggestion on the screen for drawing a line; Figure 2.42, example 

of a suggestion before the command line). 

Often, with the suggestions before the command line at the bottom left of the main screen, 

other subcommands are available (to the right of the command line). When the 

subcommands are visible, to use them just write them in the command line and click on 

enter (or simply click on them). 

The subcommands are very intuitive to use, however there is a command that is worth 

analyzing, the ‘pro’ command for properties (Figure 2.43, second command from the right). 

This command opens the Quick entities selection window (Figure 2.44), which consists of 

two tabs. The first tab called ‘CAD entities’ allows you to select entities by referring to one 

feature or another, e.g. color and type of line. The second tab is called ‘Topographic Points’ 

and allows you to select the points based on their characteristics. As you can see in Figure 

2.45 a wide range of attributes is available, from points with a given point symbol to point 

in the same fieldbook. 

 

 

 
Figure 2.39 

 

 
Figure 2.40 
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Figure 2.41 

 

 
Figure 2.42 

 
Figure 2.43 
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Figure 2.44 
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Figure 2.45 

 

The commands in the Draw section can be used with OSNAP (object snap) functions, such 

as OSNAP on the ends or midpoints. Note that by default the program starts with an OSNAP 

active on the ends. This setting can be changed at any time by clicking on the Osnap (on/off) 

button at the bottom of the main screen, shown in Figure 2.46 in dark gray (active). 

All the OSNAP modes are represented by the icons in Figure 2.47, passing with the mouse 

on them you will see a suggestion on the functionality of the command. 

 

 
Figure 2.46 
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Figure 2.47 

In the Modify section of the CAD tab (Figure 2.48), you can find all the functions for 

processing CAD entities. The names and the icons of the commands are very intuitive, and 

each command has a tooltip that briefly explains what its functionality is. Among the 

available commands there are explode, group, ungroup; these commands are useful for 

working with CAD entity groups. The Cut box window command generates a window as in 

Figure 2.49, where it will be possible to create a new job by selecting a portion of the window 

of the current job, the cutting window can have a frame with customizable graphic 

characteristics and layers. 

 

The Properties button generates a window that summarizes the properties of the selected 

entity, the system recognizes what type of entity it is and at the bottom it shows this 

information (Figure 2.50, in this case it is the properties of a polyline). 

 

There is also a command to copy the properties of one entity on another and a command 

to change the order in which the drawings are displayed. 

 

 
Figure 2.48 
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Figure 2.49 
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Figure 2.50 

Figure 2.51 shows a popup window related to the Edit poly command. The submenu contains 

commands for modifing the polylines, for example by inserting a vertex or by removing it. 

The use is very simple and, like any other CAD command, just follow the suggestions that 

appear on the screen. 

 
Figure 2.51 
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2.4 Measures (tab) 

 

The functions in this section (Figure 2.52) are used to calculate and display information on 

surveys’ data. This section is divided into three areas below: Measure, Calculations, 

Dimensions (available only in the program Cube-manager). 

 

 
Figure 2.52 

 

The Coordin. button will give the possibility to choose a point and then show the Cartesian 

coordinates (with the addition of the height) of that point, as shown in Figure 2.52. 

 

 
Figure 2.53 

The Distance will give the possibility to select two points and measure the distance between 

them. The information provided by this function is the 3D distance, the horizontal distance, 

the components along the three axes, the azimuth angle and the zenith angle (the graphic 

appearance of this information is like that one shown for the Coordin command). 

 

The Angle button will give the possibility to select 3 points: the start point, the midpoint and 

the end point. This function will calculate a clockwise angle and a counterclockwise angle 

(the graphic appearance of this information is like that shown for the Coordin command). 

 

The Area button will allow you to insert the first point in which to start calculating the area, 

then the application will continue to ask to select the next point (up to n points) to draw the 

shape for the area measuring; after selecting the last point, just type the command "en" (in 

the command line, from the "end" command) so the function will compute the calculation. 
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The area and the perimeter of the drawn shape will then be displayed in a popup window, 

with a graphic like the one shown for the Coordin command. 

 

The Entity List command, in the Calculations section, provides a list of the elements in the 

project, the list is presented as an editable text file. It is also possible to select just a part of 

the entities to display them in the list (Figure 2.53). 

 

 
Figure 2.54 

  



 

 

 

 

 

 

Stonex Cube-link v4.3 – User manual     47 

2.5 Topography (tab) 

 

The topographic section (Figure 2.55) consists of four subsections: Topographic points, 

manage coordinates, Fieldbook and Fieldbook schema (available in the program Cube-

manager). In the Topographic points it is possible to draw a new topographic point, to 

modify the characteristics of an existing one, to select the CAD entities to be used to create 

new points and to see all the points of the project grouped in a table. The Various operations 

command, if clicked, opens a drop-down menu with the commands as in Figure 2.56 (the 

Edit symbols command is not available in Cube-link). In the Fieldbook section there are the 

commands to work with polar fieldbooks. You can manually create a fieldbook, import it 

from the PC or import it directly from the total station and export coordinate files. 

 

 
Figure 2.55 

 

 

 
Figure 2.56 

 

2.5.1 Topographic points 

 

The Topographic points section is shown in Figure 2.57. The New command is used to insert 

new topographic points, by clicking on this button, you can access a window (Figure 2.58, 

Topographic point properties), where you can insert and customize the graphic properties 

of the created point. 
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The properties are completely customizable (note: it is possible to create a point with the 

properties that the application sets by default, e.g. the cross as symbol) and you can select 

the layer to which the point must belong (by clicking on search button next to the Graphic 

layer label). The Select Layer window (Figure 2.59) shows a list of available layers, all of which 

can be activated or deactivated, locked or selected. You can add new layers by clicking on 

the Add Layer button on the bottom left. 

You can also change the name of the point and the font used. You can also change the text 

color selecting a new one in the window in Figure 2.60, by clicking the search button next to 

the Text color label. This window allows you to select a color from one of the available 

clusters (general colors, grayscale, main colors or layer). 

 

 
Figure 2.57 

 
Figure 2.58 
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Figure 2.59 
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Figure 2.60 

 

The symbol is another feature that can be customized. You can choose a symbol to assign 

to the point (Figure 2.61, drop-down menu for symbol selection), you can define its size, 

color (with a selection window equal to the text color selection) and the rotation angle of 

the symbol. 

Offset X point-text and Offset Y point-text are the text positions calculated from the origin 

of the point (If not entered directly, the value of the xy offset is calculated based on the 

values of the text height and symbol size, so that the first line of text is centered with respect 

to the symbol). 

As for the Description label, by clicking on the icon next to the label you will access a window 

where you can view a list of possible descriptions (Figure 2.62). You can select existing 

descriptions or add new ones, saving the file with the destination to be specified. If a similar 

file has already been saved, you can select it and display it to use it. 

When all the graphic properties have been set, it is possible to insert the point by identifying 

the position with the mouse or by manually entering the coordinates from the command 

line. 
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Figure 2.61 

 
Figure 2.62 
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The COGO commands (Figure 2.63) are available in the program Cube-manager. 

 

 
Figure 2.63 

By clicking Points from CAD entities (in Figure 2.57), you can access two commands: 

Characteristic Points and Equidistant Points or with steps (only available in the program 

Cube-manager). Using the first, you can select one or more CAD entities to create 

topographic points. In the Characteristic Points window (Figure 2.64), you can select a layer 

(having access to the Select Layer window, as explained above). You can enter the name of 

the starting point and delete the overlapping points. Within this function you can further 

filter the CAD entities to be used by marking the available choices. 

The second command, the Equidistant Points or with steps, can be used to create 

topographic points by dividing a CAD entity into equal parts or based on a step, to use the 

command just follow the instructions that appear next to the command line. 
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Figure 2.64 

Returning to the section in Figure 2.57, the next command to explain is the Properties 

command (Figure 2.65), once you have selected one or more topographic points you can 

use this function to discover all their properties and to modify them. 

This window consists of four tabs: General, Graphics, Coordinates, Image. 

In the General tab you find information about the name, description, point code. From this 

screen you can set the information displayed in graphics as point label (point text). To 

change the label of the point just select the items you want to insert from the drop-down 

menu and press the insert button (one item at a time), you can also set the X and Y offset of 

the point text. 

The Graphics tab provides information about the font (font, size, color) and the symbol (icon, 

size, color, rotation) of the point. 

In the Coordinate tab (Figure 2.66), you can read the coordinates Est, North and Quota (as 

average of the coordinates of the various origins of the point), with the relative standard 

deviation. You can change the coordinates manually by selecting the fixed coordinates 

command. In the table called Origin of the coordinates, the origins of the selected point are 

shown, for each origin the name of the fieldbook, the type of origin, the station from which 

it is measured, and the coordinates are reported. 

The buttons below the table are: Create new point from selected origin (available only in 

presence of multiple origin); Properties of the selected origin (opens a screen as in Figure 

2.65, where you can view all the information related to the point, some are editable other 

read-only); Fixed coordinates from selected origin. 
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The Image screen allows you to see if and which images are associated with the selected 

point. 

 

 
Figure 2.65 

 
Figure 2.66 
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Figure 2.67 

 

By clicking on Table points button in Figure 2.57, you can create a table with a list of all the 

points in the project that will be grouped together with their coordinates, names, 

descriptions and codes, as shown in Figure 2.68 (an example of a table with 128 points in 

memory). 
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You can also print the table with the Print button. This button will open a text file editor 

where the table with all the points will be visible, at this stage the table can be modified in 

its fields, contents and graphic appearance. 

 

 
Figure 2.68 

 

The commands that are grouped together in Various operations command menu, in Figure 

2.56 are: Rename points, Text properties, Text offset; their use is rather intuitive and are only 

the repetition for the convenience of the user of some functions already present in the 

Topographic Point Properties window. 

 

  



 

 

 

 

 

 

Stonex Cube-link v4.3 – User manual     57 

 

2.5.2 Manage coordinates 

 

The Manage coordinates section is shown in Figure 2.69, each of these commands opens 

pull-down menus with other subcommands. Below the description of all af them. 

 

 
Figure 2.69 

2.5.2.1 Reference system 

 

This command consists of four subcommands, each of which opens a new screen. 

Preset reference system (Figure 2.70) allows you to select a reference system and save it as 

a default system (the program must always have a set reference system and will 

automatically take the user to this window, if no reference system is set). In this screen you 

can select the country and and its Projections, among those available. You can also select 

the Geoid from the drop-down menu that will show all available ones. Note that it is always 

possible to insert a new geoid in the program, thanks to the Upload utility files command 

described in par. 2.1.4. Cube-link supports all major geoid formats: GGF Files; UGF Files; GEO 

Files; GRD Files. 

A Projection can be changed in its values by clicking on the Create New button, so the new 

edited projection can be saved (it is saved in the previously selected country, in the 

projections’ drop-down menu, in the last position.) To delete it, press Create again, select 

the Projection and click delete). By clicking Show parameters, you can view the values of the 

chosen Projection. 

 

The local reference system command leads to the screen in Figure 2.71. Setting a local 

reference system deletes the predefined reference system. To access the local reference 

screen, there must be at least one topographic point in the active project, considered as the 

origin point. Normally the program will select the first point of the list as the origin point, 

you can always select a new point, among those available on the left at the bottom of the 

list of points. On the right side of the screen you can set the Geoid, the Ellipsoid and some 

of its values, it can also be set the method of calculation that you intend to use in the 

generation of the system. 

 

The Calculation 7 parameters command (Figure 2.72) in available only in the program 

Cube-manager.  
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Add preset system opens a screen as in Figure 2.73. This window with the relative 

functionalities is the same that is generated if you press the Create new button from the 

screen relative to the Preset reference system command.  

 

 
Figure 2.70 
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Figure 2.71 
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Figure 2.72 
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Figure 2.73 
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2.5.2.2 Rototraslation 

 

In the Rototranslation command (Figure 2.74), there are the functions Translate points and 

3D/2D Rototranslation. The second command is available in Cube-manager, M module - 

Modeling. 

By clicking on the Translate points button you access a window in which a list of fieldbooks 

present in the project is displayed (Figure 2.75). The translation can be performed on all 

points (default choice, Select all points checked) or on selected filedbooks. It is therefore 

possible to set an East translation and/or a North translation and/or a Height translation 

with the relative scaling factors. The exchange of coordinates can also be performed (the 

first choice, selected by default, does not perform any exchange). 

 

 
Figure 2.74 

 
Figure 2.75 
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2.5.2.3 Coordinates conversion 

 

 

The Coordinates Conversion command opens a submenu consisting of three commands: 

Stake-out GPS, Stake-out TS and Coordinates Conversion (as in Figure 2.76). The third 

command is available in Cube-manager, T module - Topography. 

By clicking on Stake-out, you can convert the grid coordinates to GPS geographic 

coordinates. After selecting the points (both CAD and topographic) that you want to convert, 

the program will switch to the screen as in Figure 2.77. From here you can define from what 

survey to calculate the stake-out (mandatory), and from which station (mandatory). The 

station may exist, or a new one can be created. Then you can define the options for the new 

topographic points (only in case of CAD points) and for the baselines. 

 

 
Figure 2.76 
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Figure 2.77 

 

By clicking Stake-out TS instead, you can select the points to build a fieldbook from Total 

Station. In Figure 2.78 is shown the window for this command, on the left you can select the 

station and orientation, from the list on the right you can select the points you want to 

include as measures of the inserted station. 

In the table below it is possible to view the fieldbook being created, the structure is similar 

to that which will be described in the next paragraph relating, to the Totals stations’ 

fieldbook. 
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Once you have completed the insertions of the fieldbook, you can create a text file or enter 

the processing screens of the fieldbook (Confirm fieldbook command), where you can 

perform all the classic operations available in the program on the fieldbook from total 

stations (the functions will be described in detail in the next paragraph). 

 

 
Figure 2.78 
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2.5.3 Fieldbook 

 

In this section (Figure 2.79) you can import a fielbook as a file, download it from total stations 

or write it manually. The operations that can be performed on the fielbook are the 

memorization, calculation and export of the points calculated in the CAD. The program 

controls the measurements of horizontal, vertical, direct and inverse readings and performs 

the averages. The program also checks for points with the same name measured several 

times within the same station and check that the measurements are averaged. Note that the 

information displayed, when importing a Total station file does not show the raw files, what 

is displayed is the result of a reading and interpretation of the data by the application. 

 

 
Figure 2.79 

 

2.5.3.1 Edit fieldbook 

 

By clicking on the Edit fieldbook button, you access a submenu as shown in Figure 2.80. 

 

 
Figure 2.80 

 

The available functions are: New fieldbook (manual), Open existing fieldbook, Create 

fieldbook from file (with extension from Stonex Total stations), Fieldbook from job. 

 

By clicking on New fieldbook (manual), you can manually write a fieldbook; in the first screen 

that follows (Figure 2.81) you can give a name to the fiedlbook (mandatory choice, otherwise 

the program will not allow you to proceed), and then enter a series of other information 
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related to the latter. All fields are left blank, only the date is set automatically by the system, 

but can be changed. 

 
Figure 2.81 

 

The next screen clicking OK automatically leads to the first measurement (Figure 2.82), by 

default the name of the first station is St1 and is defined as temporary ("Temporary" means 

that the coordinates have not been calculated, "Calculated" means that the coordinates have 

been calculated in the field and "Known" means it has known coordinates). The height of the 

instrument is set to 1.00 m, all other details are left blank and can be entered by the user. 

Even the details provided as default settings can be changed. As for the Information label, if 

you click on the icon next to it, you can access a function like the one described above (Figure 

2.62). 

 

In the section related to the details of the point, the default assigned name is Pn1 and its 

coordinates are considered temporary (with the same logic used for the stations). Other 

values set by default are the height of the pole, the vertical reading, the temperature and 

the pressure, these values can always be changed. 

For horizontal readings, vertical readings and distances, the application dynamically 

calculates the averages and residuals, returning a correct value also based on the settings of 
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the survey elements (right on the screen: prism constant, temperature, pressure, transverse 

eccentricity, horizontal eccentricity). 

 

By clicking on the icon with the wrench on the right, you can access the list of parameters 

related to the fieldbook (Figure 2.92). Parameters for setting the decimals you want to 

display on the screen and the representation of the angles. Furthermore, it is possible to set 

a series of tolerances and a series (on the right) of other values, which the system will 

consider when calculating the measurements. 

 

At the bottom of the screen (Figure 2.82), it is possible to read the information resulting 

from the calculations (considering the set parameters), relative to the horizontal distance 

and the height difference, including the difference in height between the height of the 

instrument and the height of the prism. 

 

 
Figure 2.82 

 

After entering the information of the new station and the new point, clicking the Add button, 

the application will open a new screen (Figure 2.85), where you can view a table with all the 

stations created and their points. The lines in the table are yellow or white, alternating each 

time the station changes so it will be easy to identify briefly the passage from one station to 

another. 
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In the table screen you can enter a new station and its first measurement or a new 

observation. In the first case the station name will be sequential to the last one inserted and 

the point name will be left blank, in the second case the name of the station remains the 

same and the name of the point will be sequential to the last one created. 

With the right-click on the table, you access a menu of options that, depending on the 

selection made (number of cells and position) offers a series of functions (Figure 2.84, some 

options seem to be disabled but they are all available, for facilitate the use of the menu some 

functions become dynamically active while others are deactivated). 

These functions are simple to use, you can insert a new measure between the already 

inserted observations (Enter observation), you can add a new observation at the end of the 

table (Add observation), you can change the entered numerical values as well as the names 

of the points and the selected lines can be deleted. 

These operations can be canceled by clicking the icon at the bottom left of the screen (blue 

undo icon). 

 

When all the observations have been entered, it is possible to press the End of manual entry 

button and the screen will automatically change its appearance (Figure 2.85); you can see 

the table and, in at the bottom-left you can select the desired station, to place the visible 

part of the table on it. 

 

 



 

 

 

 

 

 

Stonex Cube-link v4.3 – User manual     70 

 
Figure 2.83 

 
Figure 2.84 
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Figure 2.85 

 

 

In Figure 2.85 the command on the top-left, Fieldbook menu, if clicked will offer a series of 

operations possible on the fieldbooks (Figure 2.86). It is mandatory to use one operation to 

proceed. 

 

In the Fieldbook menu, the Calculations command consists of four subcommands: Traverse 

calculation, Detail calculation, Various calculations, 2D network calculation. The only 

calculation available in Cube-link is the detail calculation, the others are available in Cube-

manager, T module – Topography. 

To carry out the detail calculation, just click on the relative command that will lead to the 

screen in Figure 2.87, on the left is the list of stations present in the job, you can select and 

calculate one or more stations by clicking on them, or you can calculate all the stations by 

clicking on the Transfer all button. 

 

The list named Stations to be calculated will show the stations that you chose to calculate, 

when you click on Proceed, if the system does not find known points, it will generate a screen 

(Figure 2.88), where you can select the station and the first orientation (coordinates can be 

assigned/changed if necessary). To start the calculation, it is possible to click on Confirm 
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calculation (Figure 2.89). Uncalculated stations will be displayed in the list on the right, 

named Stations not calculated; help messages will appear below the list (in this example, 'All 

stations calculate ', 'All backsights in the expected tolerance’). View report button will show 

an html file with the details of the calculation, the Repeat calculation button will perform the 

calculation again. On the right there are the differences of East, North, Height between the 

maximum and minimum values found in the work, this information can help to find errors. 

The X-gray icon will delete from the list of stations to be calculated the one selected, the 

trash icon will erase all stations in the list. The icon with the wrench leads to a window like 

the one shown in Figure 2.92. 

 

Returning to the commands in Figure 2.86, View all measurements, View averaged 

measurements and Calculate averages are other available functions, the first two are display 

options, the last, work on the fieldbook, taking all the measures into consideration and 

calculating the averages. 

This last function (Calculate averages) opens a screen (Figure 2.91) in which it is possible to 

set tolerances, text colors, layers, symbols and relative colors (for known points, detail points 

and stations), decimals, representation of the angles and corrections (such as atmospheric 

refraction), clicking Proceed the program will proceed to the average calculation. 

 

The Load known points command opens a menu with three options: Read from file, Read 

from current job, Cancel known points. The first command opens a screen where you can 

select a text file containing the coordinates and indicate a separator character (Figure 2.90). 

 

Work parameters will open a window as in Figure 2.91. 
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Figure 2.86 

 
Figure 2.87 
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Figure 2.88 

 
Figure 2.89 
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Figure 2.90 
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Figure 2.91 
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Figure 2.92 

 

Among the commands shown in Figure 2.86, the Enable manual entry button will lead to the 

manual writing section of the fieldbook (described above). 

 

The View report command will open a screen with a html file containing all the information 

on the current fieldbook. If the program recognizes that there are several reports present in 

the job, a window will open in which all the reports will be displayed so that you can select 

the one you want, in this screen you can also delete (one or more) reports. 

 

Insert fieldbook in the job button will insert the fieldbook in the graphics; before proceeding, 

the application will check the presence of average measurements and if the calculations have 

been performed, then it will be possible to see again a summary of the measurements (any 

unaveraged measurements will be visualized on red lines, so that corrections can be made).  

 

With the Memorize fieldbook you can save the fieldbook; after displaying the screen with 

general information (e.g. fieldbook name, date, location, etc.), once you have chosen the 

destination for saving, the application will produce a file with the .cubefbk extension. 

The Print fieldbook command allows access to the general information screen on the 

fieldbook (as in Figure 2.81, where you can change all the fields if necessary), when you click 

on Proceed the application creates a html file, ready to print. 
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The last commands are related to the export, the fieldbooks can be exported in GSI format 

(18 and 6 bit), in IDX and in text files (as well as in the native format of the program .cubefbk). 

 

2.5.3.2 Import and export fieldbooks 

 

The Import fielbook button (Figure 2.93) allows to import fieldbooks from total stations; you 

can import using a USB connection by connecting directly to the total station (after clicking 

on the chosen device, click on the Connect USB button) or selecting a file that may be stored 

in the PC. Figure 2.93 shows all supported devices (in Figure 2.94 shows all the extensions 

supported). 

The Export coordinates button allows you to export to the total station formats and to GSI 

(16 bit and 8 bit). 

 

 

Figure 2.93 

 

 
Figure 2.94 
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2.5.3.3 Leveling 

 

The Leveling command consists of three subcommands: Download (available for free in 

Cube-link); Trigonometric leveling (available in Cube-manager); Geometric leveling 

(available in Cube-manager, Figure 2.96). The first opens a screen as in Figure 2.95. 

After selecting (at the top) a data destination file and setting the data for the input port, you 

can download data from a digital level. 

 

 
Figure 2.95 
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Figure 2.96 

 

2.5.4 Fieldbook schema 

 

Availability Module 

Cube-manager (Figure 2.97, Figure 2.98) P-T-M 

 

 

 

 
Figure 2.97 
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Figure 2.98 

 

2.6 Raster 

 

The advanced functions for working on raster images are available in Cube-manager, 

however the commands Import raster and Delete raster are also available in Cube-link. The 

formats supported in import are: BMP; GIF; EXIF; JPG; PNG; TIF; TIFF. 
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3 Tool and commands  
 

3.1 Tools and commands of the software 

 

Cube-link supports 2D, 3D and fieldbook view. The windows can be used at the same time, 

Figure 3.1. 

 

  

 
Figure 3.1 

 

The fieldbook view allows the management of surveys (GNSS and TS) present in the current 

project. 

By operating on the summary tree (Figure 3.2), it is possible to insert a new survey and/or 

new elements to the survey. Depending on the selected node, the program will automatically 

propose a GPS or TS insertion. After entering the name (Figure 3.3), the insertion will be 

automatic and visible in the grid and in the CAD, if the new element points to an existing 

topographic point, it will take its coordinates and characteristics, otherwise it will be created 

with default values. 

If you want to add a new survey it will be necessary to insert in addition to the name also 

what kind of survey it is (Figure 3.4). 
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Figure 3.2 

  

 
Figure 3.3 
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Figure 3.4 

 

By acting on the grid, for the editable columns, you can edit the individual values (Figure 

3.5) or modify the values by selecting multiple rows or multiple cells Figure 3.6 (right click 

on the selection). In the case of multiple selection of multiple columns, the functions 

available are those shown in Figure 3.7. Rename will act on the elements of the selected 

rows, Copy will copy the elements and allow you to paste the object only in the fieldbook 

grid (even of other instances of Cube-manager, different from the current, without closing 

the current). The Copy text allows a copy of the textual value of what has been selected, in 

all the applications that support the paste text function. The command Delete, deletes the 

selected element or elements. 

  

 
Figure 3.5 
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Figure 3.6 

 

 
Figure 3.7 

 

The renaming of a single element will bring up a dialog box, like the one shown in Figure 

3.8, at the top, the name change that is being carried out is shown, below it must be selected 

the function you want to perform. The Rename the point, will rename all the elements of the 

survey and the topographic points from the starting name to the new name (if the name 

already exists the function will not be completed). 

The second choice, Rename the TS measure (which changes according to the element of the 

selected survey), will rename only the element of the selected survey, if you enter an existing 

name, the program will ask for confirmation of what you want to do as in Figure 3.9, clicking 

YES, the result will be like that obtained with the Rename the point, clickng NO only the 

selected element will be renamed and will be connected to the existing name element. 
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Figure 3.8 

 

 
Figure 3.9 

 

If you rename a station of a survey from Total station, you will need to manually rename the 

measurements you want to connect to the renamed (created) station, the program will 

always generate a warning message. 

 

 The change of value with multiple selection (Figure 3.6), generates a window as in Figure 

3.10, on the left you can choose what type of operation you want to perform and, on the 

right, you can enter the value. 

Changing the East, North, and Height coordinates of an unknown point leads to its 

transformation into a known point. 
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Figure 3.10 

 

List of all commands that can be used by the command line (Figure 3.11) of the program, 

the commands are case insensitive: 

 

Command Description 

OPEN Opens projects (Cube-link files with extension .cubelnk) 

SAVE Saves the project ( with extension .cubelnk for a normal 

file, with extension .cubetpl for a template file) 

NEW New project 

DXFIN Imports dxf/dwg files 

ASCIIIN Imports generic ASCII files 

SHAPEIN Imports ESRI Shapefiles 

RW5IN Imports RW5 files 

CUBEAIN Imports Cube-a files 

GEOGISIN Imports GeoGis files 

DXFOUT Creates dxf/dwg files 

KMLOUT Creates a KML file for Google Earth 

MAPWWW Creates a map 

PRINT Prints the drawing 

CUBEAOUT Creates a Cube-a file 

RW5OUT Creates a RW5 files 

GEOGISOUT Creates a GeoGis files 

SHAPEOUT Creates an ESRI Shapefile 

COPYNOTES Copies CAD entities to notes 

PASTENOTES Pastes the CAD entities from notes 

SETTINGS General program settings 

QUIT Closes the program 
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2DVIEW Enables 2D view 

3DVIEW Enables 3D view 

ZOOMLI Zoom limits 

ZOOMIN Zoom in 

ZOOMOUT Zoom out 

ZOOMWI Zoom window 

ZOOMPT Zoom on topographic point 

DYNPAN Activates dynamic pan 

ZOOMMA Enables/disables zoom window 

AERIALVIEW Enables/disables the panoramic view 

POINT Draws a point at the selected location 

LINE Line on2 points 

CIRCLE Circle with choice of options 

CIRCLECE Center and radius circle 

CIRCLE3P 3-point circle 

CIRCLE2P 2-point circle 

CIRCLETTR Tangent, tangent and radius circle 

ARC Enables arc design options 

ARC3P Arc on 3 points 

ARCCE Arc center, radius, beginning and end 

ARCBE Arco beginning, end and radius 

POLYLINE Draws polylines 

RECTANGLE Draws a rectangle 

POLYGON Draws a regular polygon 

ELLIPSE Draws an ellipse 

TEXT Start command for multiline text insertion 

DELETE Deletes CAD entities 

MOVE Moves CAD entities 

COPY Copies CAD entities 

ROTATE Rotates CAD entities 

OFFSET Offset of the CAD entity 

JOIN Connects to entities 

FILLET Connects with arc 

EXTEND Extends an entity to the limit 

TRIM Trims entities 

BREAK Breaks entities 

GROUP Groups CAD entities 

UNGROUP Ungroups CAD entities 

EXPLODE Explodes complex CAD entities 

PROPERTIES Modify the properties of CAD entities 

COPYPROP Copies properties from a CAD entity 

DRAWINGORD Changes view order 
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FOREORDER Brings to foreground 

BACKORDER Sends to background 

INSPTONPOLY Inserts polyline vertex or profile vertex 

DELPTONPOLY Deletes a vertex from a polyline or a profile 

MERGEPOLY Joins two polylines into a single polyline 

POLYINHEIGHT Sets all the vertices of a polyline to a set height. 

LAYER Opens the layer properties manager window 

LAYERFROMENT Activates layer from entity properties 

CURRLAYER Moves on current layer the selected entities 

ISOLALAYER Isolates the layers of the selected entities 

LAYEROFF Turns off the layers of the selected entities 

LOCKLAYER Blocks the layers of the selected entities 

LAYERONOFF Turns the current layer on or off 

ALLLAYERON Enables all layers 

UNLOCKLAYERS Unlocks all layers 

VIDEOTHICK Displays video thicknesses 

SYMBOSNAP Sets the osnap symbol size 

ROTAXES Sets the cursor axes rotation 

AXESSIZE Sets the cursor axes size 

VIDEOSCALE Scales the video display 

GRAPHICBGROUND Sets the background color of the graphic window 

CURSORINFO Sets dynamic info on the cursor (values from 1 to 7) 

ORTHO Enables/disables Ortho 

OSNAP Enables/disables osnap 

NEWPT Creates a new topographic point 

CHARACPT Creates topographic points from CAD entities 

PTPROP View (edit) properties of the topographic point 

PTTABLE View topographic point table 

RENAMEPT Rename topographic point 

PTOFFSET Edit point-text offset 

R1PLUS Imports a fieldbook from a file with .dat or .r15 extension 

R2LPLUS Imports a fieldbook from R2L Plus file / R25 

R2/R2SPLUS Imports a fieldbook from R2S Plus file  

R2WFG Imports a fieldbook from Fieldgenius file 

R2WSC Imports a fieldbook from SurvCe/RW5 file 

R2WAM Imports a fieldbook from AntasMobile file 

EXPR1PLUS Exports coordinates in R1 Plus file format 

EXPR2PLUS Exports coordinates in R2 Plus file format 

EXPR2LPLUS Exports coordinates in R2LPlus file format 

EXPR2PLUSRAW Exports coordinates in RAW file format 

EXPR2PLUSRW5 Exports coordinates in RW5 file format 

EXPR2WCSV Exports coordinates in AntasMobile file format 
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EXPGSI16 Exports coordinates in GSI 16 bit file format 

EXPGSI8 Exports coordinates in GSI 8 bit file format 

NEWFIELDBOOK Opens a window where to create a new fieldbook 

OPENFIELDBOOK Imports an existing fieldbook 

LOADFIELDBOOK Imports a fieldbook in one of the supported formats 

FROMFIELDBOOK Reads fieldbook presents in the project 

DOWNLOADLEVELING Download data from a digital level 

TRANSLATEPTS Opens the window where you can translate points and 

exchange coordinates 

PTTOGPS Starts the GPS Stakeout function 

PRESETSYSTEM Sets predefined reference system 

ADDNEWSYSTEM Create new reference system 

DELETERASTER Delete raster image 

RASTERIN Import raster image 

 

 

 

 

 
Figure 3.11 

 

 

Another useful tool other than the command line is the Quick selection (Figure 3.12); in 

commands that involve selecting CAD entities or topographic points, with the right-click you 

can enter a menu that allows you to access a quick entity selection. Selection is divided into 

topographic and CAD entities and takes place through the choice of the respective 

properties. From this popup window, you can also quickly access the entity properties 

window. 
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Figure 3.12 

Double clicking on the mouse-wheel will execute a zoom limits. 

 

The project manager panel (Figure 3.13, middle-left part of the main screen), is a tree 

structure that contains all the topographic and raster entities present in the project. With 

the double-click on the points you can select them as an alternative to graphic selection.  

 

 

 
Figure 3.13 

 

The project manager panel can be switched on or off by pressing the Show/Hide button at 

the bottom-left of the main screen (icon in the red circle, Figure 3.14). While the two icons 

to the right of the command line have the function to recall the system calculator (the first 

from the left) and open a file with the date, time and description of the commands entered 

in the current working session (the second). 
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Figure 3.14 

 

 

At the bottom of the screen, you can see the coordinates of the elements in the project, 

enable or disable the Osnap mode, the Ortho view and the Polar view. Also thicknesses and 

grids can be activated or deactivated. 

 

Activating the Reference grid generates a window as in Figure 3.15. In this screen it is 

possible to create the ref grid by defining the type and scale at the top. In the main panel, 

the construction values of the parameters can be set (default values are always available), at 

the bottom you can set whether to build an external frame and with what characteristics. 

The Frame captions command opens a screen as in Figure 3.16 where you can choose the 

characteristics of any writes. By pressing the Reference grid button in the main interface, you 

can deactivate it (if a ref grid is found in the active job, you can delete or deactivate it, or 

create a new one). 
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Figure 3.15 
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Figure 3.16 

 

By clicking the Tools bar button (Figure 3.17), you can customize the layout and display of 

available shortcuts (Figure 3.18, all the entries for the available shortcuts. To reposition them 

on the screen, click on the 5 left-side dots, to drag and drop the commands). 

 

 

 
Figure 3.17 
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Figure 3.18 
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